## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>6</td>
</tr>
<tr>
<td>In the Box</td>
<td>6</td>
</tr>
<tr>
<td>Braille Trail Reader - Physical Description</td>
<td>6</td>
</tr>
<tr>
<td>Top Surface</td>
<td>7</td>
</tr>
<tr>
<td>Braille Display</td>
<td>7</td>
</tr>
<tr>
<td>Braille Keyboard</td>
<td>7</td>
</tr>
<tr>
<td>Joystick</td>
<td>7</td>
</tr>
<tr>
<td>Front Edge</td>
<td>7</td>
</tr>
<tr>
<td>Thumb Keys</td>
<td>7</td>
</tr>
<tr>
<td>Left Edge</td>
<td>7</td>
</tr>
<tr>
<td>Power Button</td>
<td>7</td>
</tr>
<tr>
<td>Micro USB Port</td>
<td>8</td>
</tr>
<tr>
<td>Right Edge</td>
<td>8</td>
</tr>
<tr>
<td>Back Edge</td>
<td>8</td>
</tr>
<tr>
<td>Application/Terminal Mode Switch</td>
<td>8</td>
</tr>
<tr>
<td>Charging the Battery</td>
<td>8</td>
</tr>
<tr>
<td>Powering On/Off</td>
<td>9</td>
</tr>
<tr>
<td>Restore to Default Settings</td>
<td>9</td>
</tr>
<tr>
<td>Installation and Connectivity</td>
<td>9</td>
</tr>
<tr>
<td>Connecting with USB</td>
<td>9</td>
</tr>
<tr>
<td>Connecting with Bluetooth</td>
<td>10</td>
</tr>
<tr>
<td>Connecting to a PC or Notebook (in Terminal Mode)</td>
<td>10</td>
</tr>
<tr>
<td>Connecting a Screen Reader</td>
<td>11</td>
</tr>
<tr>
<td>JAWS Screen Reader</td>
<td>11</td>
</tr>
<tr>
<td>Other Screen Readers</td>
<td>11</td>
</tr>
<tr>
<td>Pairing the Braille Trail Reader with an iPhone (in Terminal Mode)</td>
<td>11</td>
</tr>
<tr>
<td>Pairing the Braille Trail Reader with other Mobile Phones (in Terminal Mode)</td>
<td>12</td>
</tr>
<tr>
<td>Waking Up Your iOS Device Using the Braille Trail Reader</td>
<td>12</td>
</tr>
<tr>
<td>Braille Trail Reader Menu</td>
<td>12</td>
</tr>
<tr>
<td>Navigating the Menu</td>
<td>13</td>
</tr>
<tr>
<td>Menu Items</td>
<td>13</td>
</tr>
<tr>
<td>Clock</td>
<td>13</td>
</tr>
<tr>
<td>Notes</td>
<td>13</td>
</tr>
</tbody>
</table>

Braille Trail® Reader LE *User’s Guide*
Synchronizing Braille Trail Reader Data

Application Mode

Synchronizing with Gmail
Synchronizing with Outlook
Synchronizing with iCloud
Synchronizing with an iPhone

Creating and Saving Files

Creating, Editing, and Saving Notes
Creating and Saving Files

Synchronizing Braille Trail Reader Data

Synchronizing with an iPhone
Synchronizing with iCloud
How to Generate an App-Specific Password
Turning on Two-Factor Authentication in Settings

Synchronizing with Outlook

Synchronizing with Gmail

Transferring Files to the Braille Trail Reader LE

Copying Files from a PC to the Braille Trail Reader (in 3 Parts)
Part 1: Copy Files from a PC Folder to the Braille Trail Reader File Transfer Windows Application
Part 2: Connecting the Braille Trail Reader with the Braille Trail Reader File Transfer Windows App

Braille Trail® Reader LE User’s Guide
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part 3: Copying Files from the Braille Trail Reader File Transfer Windows App to the Braille Trail Reader</td>
<td>26</td>
</tr>
<tr>
<td>Copying Files from PC Pane to a Windows Folder</td>
<td>27</td>
</tr>
<tr>
<td>Customer Support</td>
<td>27</td>
</tr>
<tr>
<td>Proper Trademark Notice and Attributions</td>
<td>27</td>
</tr>
<tr>
<td>Additional Resources</td>
<td>27</td>
</tr>
<tr>
<td>Technical Specifications</td>
<td>27</td>
</tr>
<tr>
<td>End User License Agreement</td>
<td>28</td>
</tr>
<tr>
<td>Manufacturer Warranty</td>
<td>28</td>
</tr>
</tbody>
</table>
Introduction

The Braille Trail Reader LE is a braille terminal that can be used with virtually any screen reader on the market, including screen readers installed on, or already part of, mobile device operating systems (smartphones and tablets). The Braille Trail Reader LE can also work in application mode, where you can use one of the applications present in the device. Combined with the Brailliant Sync app found on the Apple® App Store or Google Play™ store, users can type notes with the Braille Trail Reader LE even when it’s not paired. Using the Braille Trail Reader File Transfer application on Windows, you can also transfer text (.txt) and braille ready files (.brf) you would like to read to the Braille Trail Reader.

In the Box

The package contains the following items:

- Braille Trail Reader LE with lanyard
- USB cable
- USB AC power adaptor
- Carrying case
- Quick Start Guide (print)
- Command Summary (braille)
- Decorative Braille Bug® ladybug sticker

Braille Trail Reader - Physical Description

![Figure 1: Braille Trail Reader LE](image)
The Braille Trail Reader LE has a 14-cell braille display and an 8-dot Perkins-style braille keyboard, along with a joystick and several additional keys for navigation.

**Top Surface**

**Braille Display**
The braille display with 14 cells is located on the top surface, near the middle of the device. Above each braille cell is a small sensor, known as the cursor-routing sensor (Active Touch Sensor). Rather than needing to press a button to activate a cursor router key, you simply slide your finger up from a cell. The touch sensor detects the location of your finger and either routs the cursor to that cell or activates that item. You feel a slight vibration of the device when your finger is detected. In front of the braille display, you find the Braille Trail Reader’s ergonomic Spacebar.

**Braille Keyboard**
The keyboard has 8 braille-entry keys, located above the braille display. From left to right, the first key is Backspace, or dot 7, followed by braille-entry dots 1 through 6, and the last key is Enter, or dot 8. The Spacebar is in the middle, just below the braille display and used as a Space key (or in combination with other keys). The braille keyboard can be used to type braille or perform commands in combination with other keys (e.g., with Space). The commands depend on the screen reader used. Internal Braille Trail Reader LE applications are controlled with keyboard shortcuts described in the Application Mode section of this document.

**Joystick**
The joystick is located on the top surface, between and slightly above dots 1 and 4. The joystick has five functions: Left, Right, Up, Down, and Action. This allows for simple navigation among items. It also emulates the flick left, right, up, and down gestures found on iOS® devices. Pressing down on the joystick selects items.

**Front Edge**

**Thumb Keys**
The four keys on the front edge (closest to the user) are generally operated by your thumbs, and therefore called thumb keys to differentiate them from the main keyboard keys. These thumb keys are used in conjunction with the braille display when reading and navigating and can be operated using your thumbs without moving your fingers from the braille display. By default, the two outer thumb keys navigate from item to item, and the two inner thumb keys pan the braille display left or right.

The thumb keys are named as follows: Previous, Left, Right, and Next.

**Left Edge**

**Power Button**
The Power button located on the left edge towards the back of the device. It has a tactile dot in the middle and is slightly raised. To turn the device On or Off, press and hold this button for approximately 3 seconds. The Braille Trail Reader LE confirms with a beeping sound that it is powering On or Off. The word “starting” appears on the braille display during the boot process. The power button is also used to reset the Braille Trail Reader (when pressed and held for approximately 15 seconds).
Micro USB Port

In the middle of the left edge, next to the power button is a rectangular **USB Port**. Use the cable that came with your Braille Trail Reader to connect your device to a PC. You can also charge your device’s battery through USB.

Right Edge

The right edge has no buttons or ports on it.

Back Edge

**Application/Terminal Mode Switch**

The Application/Terminal Mode switch is a toggle switch that allows you to use the device independently or paired with another device. With the Braille Trail Reader facing you, ready for use, the **Application/Terminal Switch** is located on the left side of the back edge. Slide it to your right to put the device in braille Terminal mode—where you can pair with other devices, including screen readers (mobile or PC). Slide it to your left to use Braille Trail Reader’s internal applications (Notetaker, Stopwatch, and Settings).

Charging the Battery

**IMPORTANT:** Please fully charge your Braille Trail Reader before the first use. Prior to first use, you must charge the device for a minimum of 8 hours before using it. After first use, it takes up to five hours to fully charge the battery.

The Braille Trail Reader has a built-in rechargeable Lithium-Ion Polymer battery. To charge the battery, connect the device via USB to your PC or a power outlet using a USB AC adapter and USB cable (included in the box). The battery life of your PC is not affected significantly as the current used is very low. When the Braille Trail Reader is fully shut down, and with the charger plugged in, the Braille display shows “charging,” with the last braille cell (14th cell) showing the battery level proportionally to the number of dots. For example, if you have dots 1, 2, 3, and 4 shown, this represents 4/8 or half of the full charge. Each dot has a value of 12.5%.

You can use the Braille Trail Reader while charging. Once fully charged, the Braille Trail Reader displays “battery full” and is ready for 20 hours of continuous operation on Bluetooth® wireless technology.

You can use any universal USB AC adapter to charge the Braille Trail Reader. Just insert the USB cable’s rectangular connector into the adaptor’s USB port, insert the micro USB connector (smaller end) into the micro USB port on the left side of your device, and then plug the adapter into an AC outlet. Connecting the USB AC adapter or the USB cable attached to your computer while the device is turned Off wakes it up and “charging” appears.

The Braille Trail Reader’s battery management system includes a battery protection circuitry that prevents it from being damaged by total discharge. If the battery is low, the Braille Trail Reader warns you with a beeping sound before switching off automatically.

**Important:** Never try to replace the battery yourself as this may damage the device and void the warranty. To provide optimal battery life, the battery must be replaced by HumanWare or an authorized dealer. If your device needs repair, please contact **APH Customer Service** at 800-223-1839 or cs@aph.org.
Powering On/Off

Pressing and holding the power button for approximately three seconds turns the device **On** or **Off**. A beeping sound is heard, and “starting” appears on the braille display.

When pressing and holding the power button for approximately 15 seconds, the Braille Trail Reader resets.

If there is no action on the device (no communication with the PC and no buttons pushed on the device), it turns off automatically after the “auto-power-off” period expires. The device beeps twice when there is one minute left in the power-off period. This counter/period resets every time data is received from the PC or buttons on the device are pushed.

**Restore to Default Settings**

To restore the Braille Trail Reader to its default settings:

1. Press **Space + dots 1-2-3-4-5-6** to access the Main menu.
2. Press and hold Joystick down while pressing dots 4-5-6.
3. Release joystick and dots 4-5-6.

**Installation and Connectivity**

You can connect your Braille Trail Reader to your PC via USB or Bluetooth or to your mobile devices via Bluetooth only. When you use USB to connect the Braille Trail Reader to a Notebook or PC, the battery recharges in the process.

**Connecting with USB**

USB connectivity is supported by Windows computers (32 and 64 bits).

**Important:** You must install the Braille Trail Reader driver before connecting the braille display to your PC. Visit the [HumanWare Brailliant BI Support Page](http://www.humanware.com) to download the latest Brailliant BI 14 drivers.

After downloading the Brailliant BI 14 drivers, connect your Braille Trail Reader to your PC using a USB cable (included in the box). Plug the rectangular USB connector into your PC and the micro USB connector (smaller end) into the Braille Trail Reader micro USB port.

When you connect Braille Trail Reader LE to your PC for the first time, it is recognized automatically.

Once connected to the PC, the braille display stays connected as if connected to a serial port; the driver is simulating what is known as a virtual serial port. This is how to use the device with screen readers that can only support serial braille displays.

Installing this driver means that one USB port on the computer is perceived as a serial port, such as COM3.

To ascertain which virtual COM port has been created:

1. Go to the Start menu on the PC and select Settings.
2. Select Control Panel.
3. Select System.

4. On the Hardware tab, select Device Manager and look through the list of ports to find the virtual COM port.

**Connecting with Bluetooth**

Bluetooth is a wireless connection. Similar to the USB connection, Bluetooth simulates a virtual COM port.

Wireless technology, along with the Braille Trail Reader’s long battery life, provides freedom from wires within the range of a Bluetooth connection (approximately 30 feet). Bluetooth connectivity is common for mobile phones, PDAs, and Notebook PCs. PCs can be upgraded with Bluetooth using a Bluetooth USB dongle, which automatically installs the software upgrade on Windows 7, Windows 8, Windows 10 (and above) when plugged in.

For security reasons, Bluetooth devices must be “paired” when connected for the first time. Later, the devices recognize each other automatically (if allowed by the user).

In the Bluetooth environment of a PC, Braille Trail Reader LE is listed as:

**Brailliant BI 14 6500141XXXXX** (where XXXXX is the serial number of your unit.)

**Connecting to a PC or Notebook (in Terminal Mode)**

Your Braille Trail Reader can be used as a braille display with standard PC screen readers such as JAWS, Supernova, and others. The PC or Notebook must provide either a USB or Bluetooth connection (built-in or through a USB Bluetooth dongle). We recommend Windows 7, Windows 8, or Windows 10 for Bluetooth.

A driver is not required to connect the Braille Trail Reader to a Windows 10 PC. Simply connect the micro USB end of the USB cable to the Braille Trail Reader and the rectangular USB end to the Windows PC. The Windows PC installs the Braille Trail Reader as a standard serial communication channel.

**Note:** A COM port number is assigned at the same time as the PC installation. Make a note of this number. You may need it when setting up the Braille Trail Reader with Screen Readers.

To find out which virtual serial port is provided by a Bluetooth or USB connection in Windows, **begin with the Braille Trail Reader disconnected from the PC:**

1. If connected to the PC, disconnect the Braille Trail Reader.
2. Open the Control Panel on your PC (Start > Settings > Control Panel).
3. Select System from the list.
4. In the pop-up window, select the Hardware tab.
5. Click on Device Manager.
6. In the Device Manager directory, select Ports (COM and LPT).
7. In the sub-list, look for all entries named Standard Serial over Bluetooth link (COMXX), where XX is a number. There may be several of these. Make a note of the numbers after the COM.
8. Connect the Braille Trail Reader to the PC using the USB cable.
9. Note the new COM port number that appears in the list. This is the number of the virtual COM port the device is connected to. You need this port number to set up a screen reader.

On Bluetooth, there are two ports—one outgoing and one incoming. The **outgoing port** is the one to use to connect your device. Once connected, the serial port used by your device can also be found in the Properties of your connected device in the Bluetooth Manager.

Some screen readers do not support higher number values of COM ports. In that case, you may need to change the port number.

**To change the port number:**

1. Select Ports (COM and LPT) in the Device Manager directory and right-click on the port to change (shortcut is Shift F10).
2. Click on Properties in the Context menu.
3. Click on the Port settings tab and click on the Advanced button.
4. In the pop-up window, select a free port number from the COM Port Number List box. Numbers not available are followed by (in use).

**If you are still not able to connect the Braille Trail Reader to a PC, follow these steps:**

1. Navigate to the Brailliant COM port under the Ports (COM and LPT) in the Device Manager directory. If you do not see it, try Others.
2. A Brailliant/unknown is designated by an exclamation mark beside the assigned COM port number.
3. Right-click on the COM port to open the Context menu and navigate to Update Driver.
4. Select the option: Browse my Computer.
5. On the next screen, select the option: Let me pick from a list of installed drivers on this computer.
6. The list may show two options: the Humanware Brailliant B and BI driver and the USB Serial Device, which is the built-in USB serial driver in Windows. Select USB Serial Device and click OK.

At this point, the Braille Trail Reader should make a sound indicating that it is connected, and you should be able to continue the configuration following the regular procedure.

**Connecting a Screen Reader**

**JAWS Screen Reader**

A JAWS driver for Braille Trail Reader is included with the JAWS software. Visit the HumanWare Brailliant BI Support Page to review the Brailliant BI 14 with Screen Reader instructions.

**Other Screen Readers**

Braille Trail Reader works with Voiceover on iOS and Mac, Android, SuperNova, JAWS, NVDA, ChromeVox and VoiceView. Visit the HumanWare Brailliant BI Support Page for additional information.

**Pairing the Braille Trail Reader with an iPhone (in Terminal Mode)**

You can pair your Braille Trail Reader with an iPhone running iOS 10.3 or later by the standard Voiceover method.
1. On your Braille Trail Reader, ensure the Application/Terminal Mode toggle switch is to the right and the unit is On. This ensures that the Braille Trail Reader is in Terminal mode and ready to be paired with iOS devices.
2. From the Home screen, open Settings.
4. Activate Accessibility.
5. Activate Select Voiceover.
6. Activate Braille.
7. If Bluetooth is not turned on, you are prompted to do so.

The Brailliant 14XXXXX, where XXXXX is the serial number of the Braille Trail Reader, is now at the bottom of the list. Activate it, and it pairs automatically.

Pairing the Braille Trail Reader with other Mobile Phones (in Terminal Mode)
The Braille Trail Reader can be paired with mobile phones as a Bluetooth braille display. The pairing must be initialized from the phone, just as you would pair with any other keyboard or Bluetooth device.

**Note:** Another connection with your phone is performed over Bluetooth Low Energy for application data synchronization, using a special application called **Brailliant Sync**. Be careful not to confuse the two connections. Look for the terminal connection in the screen reader’s menus and the data synchronization Bluetooth Low Energy connection in the Brailliant Sync app.

Waking Up Your iOS Device Using the Braille Trail Reader
You can use your Braille Trail Reader to wake up your iOS device and initiate a connection between the two devices. To do this, connect the Braille Trail Reader to the Brailliant Sync app—see Synchronizing Braille Trail Reader Data section for more information. This connection is maintained by both devices, so you only need to establish it once.

To perform the wake-up, move the Application/Terminal Mode switch to Terminal mode position (to the right). If already in Terminal mode, toggle the switch to Application mode and back to Terminal mode. The iPhone or iPad (running Brailliant Sync software) wakes up for a few seconds, and your iOS device initiates a Terminal connection.

If you are having difficulties making the iOS device wake up, it could be that another device is blocking the wake-up functionality. For example, if you have an Apple Watch, you need to go to Watch application on your iPhone and choose Notifications on My Watch tab, and then find Brailliant Sync on the “Clone from iPhone” list and turn off cloning.

For more information, refer to your mobile device screen reader user guide.

Braille Trail Reader Menu

The Braille Trail Reader Menu is activated with a short press of the power button when using it in the Terminal and Application modes.

There are three types of menu items:

**Read Only:** System provides information that cannot be modified.
**Toggle:** Allows you to toggle settings using Left and Right thumb keys.

**List:** Good for choosing one item from a list. Use the touch cursor above the element you want to choose.

**Navigating the Menu**

While in the menu, use the joystick **Left/Right** or **Previous/Next** thumb keys to navigate the menu. The **Up** and **Down** joystick movements or **Left** and **Right** thumb keys are used to perform various actions depending on the type of menu.

To enter the selected menu item, use joystick **Down, Enter** (dot 8) or **Space**. Another way to choose an item is to touch the cursor routing sensor above its name.

To exit a menu, use joystick **Up** or escape shortcut **Space + E** (dots 1-5).

First letter navigation, the most powerful and efficient way of navigation, is available too. For example, pressing **N** (dots 1-3-4-5) moves the focus to the Notes application making it a more useful and simple way of accessing menu items.

You can also choose to navigate using the **Next** or **Previous** thumb keys and using a cursor router key to activate items. Pressing the key combination **Space + E** (dots 1-5) exits an existing menu or application.

Another useful feature is the command **Space + dots 1-2-3-4-5-6**, which jumps to the Main menu if you are in Applications mode.

**Menu Items**

**Clock**

This is the first item in the Main menu. The **Right** thumb key scrolls the display to show the date. Return to time display with the **Left** thumb key. Please note these are not manually set. The time and date are synchronized when you connect the Braille Trail Reader with another device via the Brailliant Sync application see **Synchronizing Braille Trail Reader Data** section for more information.

**Notes**

Notes is an application and, therefore, available only in Application mode. It is used for creating, editing, and saving notes—see the **Creating, Editing, and Saving Notes** section for more information.

**Battery**

This menu item displays battery charge information as a percentage of full charge. When panned, the display shows if the unit is being charged or not.

**Stop watch**

Stop watch is an application that shows the time elapsed since a **Space** key press. Space starts and stops the stopwatch. The accuracy of measurement is 0.1 s (one tenth of a second). Use **Space + C** (dots 1-4) to reset the stopwatch.

**Connections**

Connections is a menu item used to switch between various devices currently connected to your Braille Trail Reader over Bluetooth or USB. There may be up to two devices connected at the same time.
**Settings**

In Settings, you choose the Braille Trail Reader’s operating parameters. The Settings options and the default values for each are listed in Table 1: Settings Options and Default Values.

**Table 1: Settings Options and Default Values**

<table>
<thead>
<tr>
<th>Settings Option</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto power off</td>
<td>Off</td>
</tr>
<tr>
<td>Sleep</td>
<td>Off</td>
</tr>
<tr>
<td>Sound</td>
<td>On</td>
</tr>
<tr>
<td>Vibration</td>
<td>On</td>
</tr>
<tr>
<td>Cursor sense (Cursor Senser)</td>
<td>3</td>
</tr>
<tr>
<td>Cursor Vib (Cursor Vibration)</td>
<td>3</td>
</tr>
<tr>
<td>BRL Curs blink (Braille Cursor Blink)</td>
<td>Off</td>
</tr>
<tr>
<td>Computer Braille</td>
<td>English US</td>
</tr>
<tr>
<td>Literary Braille</td>
<td>English UEB</td>
</tr>
<tr>
<td>Default Braille</td>
<td>Literary</td>
</tr>
<tr>
<td>Language</td>
<td>English</td>
</tr>
<tr>
<td>One-handed mode</td>
<td>Off</td>
</tr>
<tr>
<td>New line indicator</td>
<td>On</td>
</tr>
</tbody>
</table>

**Auto Power Off**

The Braille Trail Reader has an auto braille shut off time when left on and not used for 15 minutes. This is to improve the efficiency of the battery. Press any key to wake up the Braille Trail Reader.

By default, this option is set to Off. To change this setting, go to Settings and select Auto Power On. You can set the time of inactivity before the unit turns off automatically. The time options for Auto power off are 3, 5, 10, 15, 20, 30, 45, 60 minutes, and Off.

**Sleep**

This feature keeps the unit powered On but turns Off the refreshable braille cells after the elapsed time, which saves battery life. You can change the length of time before the braille display becomes inactive (goes to sleep). The time options for Sleep are 3, 5, 10, 15, 20, 30, 45, 60 minutes, and Off. Press any key to wake your device when in Sleep mode.

**Sound**

This feature allows you to set sounds **On** or **Off**. When sounds are **Off**, the unit provides sound cues for actions it performs like powering On and Off, and so on.
**Vibration**
This feature allows you to change between vibration On or Off. When vibration is Off, the unit does not provide vibration cues for actions it performs.

**Cursor Sensor**
The Cursor sensor controls the sensitivity level of the Active Touch cursor. You can set it to Off (no touch cursors) or 1 (most sensitive) to 5 (least sensitive). Experiment with these settings to find the right setting for you.

**Cursor Vibration**
Controls whether there should be vibration feedback when the Active Touch cursor is activated. You can set it to Off (no vibration on touch cursors) or to 1 (most vibration) to 5 (least vibration). Experiment with these settings to find the right setting for you.

**Braille Cursor Blink**
This menu item enables the braille text cursor to blink when editing notes. The cursor, either dot 8 or dots 7 and 8, blinks when this is set to On.

To set the cursor to blink:

1. Navigate to the Main menu and press S (dots 2-3-4) until you are prompted with Settings.
2. Press Enter.
3. Press B (dots 1-2) until you are prompted with Braille cursor blink.
4. Press Enter again.
5. When prompted with your current value (where the first cell indicates the selection with all 8 dots being shown) press the Next thumb key (far right) to move to On.
6. Press Enter. The first cell shows all 8 dots followed by On.

**Computer Braille**
This menu item allows you to choose an 8-dot Computer Braille table from a list of available languages/types. An 8-dot sign marks the item that is selected.

The following Computer Braille tables are supported:

- English US
- English UK
- Arabic
- Danish
- German
- French
- Norwegian
- Dutch
- Polish
- Swedish
- Xhosa
- Zula
- Africaans

**Literary Braille**
This menu item allows you to select a 6-dot literary braille table from a list of available languages/types. An 8-dot sign marks the item that is selected.

The following literary braille tables are supported:
Default Braille
Default braille allows you to select either literary or Computer Braille table as the default when opening a note (existing or new).

Language
Language allows you to select a language from a list of available languages. The language that is selected is marked by an 8-dot sign.

The following languages are currently supported:

- English
- French
- German
- Swedish
- Turkish
- Norwegian
- Dutch
- Spanish
- Hungarian
- Arabic
- Russian
- Turkish
- Norwegian
- Dutch
- Spanish
- Hungarian
- Arabic
- Russian

One-Hand Mode
One-hand mode is helpful for users limited to the use of a single hand. To enable/disable one-handed mode, select this option through the Main menu.

1. Using the joystick, scroll to Setting and press Enter.
2. Scroll to One Hand mode and press Enter again.
3. Navigate to On and press Enter to activate One-Hand Mode.

You are notified if One-hand mode is enabled when turning on your Braille Trail Reader.

When using One-hand mode, the Spacebar must be pressed after most kinds of input are made. For example, to type a braille letter, press the corresponding braille keys either all at once or one at a time and then press Space. To use a hotkey combination like Space + E to save and exit in the editor, you need to press Space, dot 1, dot 5, and then press Space again. To make a space while in the editor, you press Space, Space.

Only the thumb keys and the joystick are not affected by the need to press Space after information input.

New Line Indicator
While editing or reading in a note, a cell showing 8 dots indicates a new line. For some, this can sometimes be a distraction when reading and can be set to Off in the settings. The default value is On.

To turn off this feature:
1. Navigate through the Main menu with the S key until you are prompted with Settings.

2. Press Enter.

3. Press N (dots 1-3-4-5) until you are prompted with “new line ind.”

4. Press Enter.

5. You are prompted with your current value, where the first cell indicates the selection with all 8 dots being shown. Press the Next thumb key (far right) to switch to Off.

6. Press Enter. The first cell shows all 8 dots followed by Off.

**About**

The About menu item displays the Braille Trail Reader’s firmware version and serial number. It includes options for starting the firmware and memory upgrade process. Press Spacebar or joystick down when the memory version is active to check if your memory is up to date.

The firmware upgrade can only be performed with a new version of firmware in a file available on a Windows computer and using Braille Trail Reader Updater Software.

**Note:** Use the firmware upgrade with caution. Any interruption during the upgrade may make the device unusable until serviced by the manufacturer.

While in the Main menu, you may restore default settings for the device. To restore default settings, use key combination: joystick down + dots 4-5-6. This combination only takes effect when at the top menu level.

**Application Mode**

Braille Trail Reader works independently when switched to Application mode (toggle switch to the left on back edge). The Braille Trail Reader has 8 GB of internal storage. This internal storage can be used to store notes created on the device or books/files that have been transferred using the Braille Trail Reader Windows application. The Notes application is only available when the Braille Trail Reader is in Application mode.

**Creating, Editing, and Saving Notes**

Notes may be created directly on the Braille Trail Reader and saved using the internal storage. Notes can also be downloaded and synchronized with a server—and via the server—with all your other devices (e.g., PC, tablet, phone, etc.) as well.

When you enter the Notes menu item, there is a list of folders—one per account, beginning with local.” This local folder is stored only in the device and does not get synchronized.

After the local folder is the files folder—see the Creating and Saving Files section for more information. In this folder is a list of files that have been downloaded to the device (with Braille Trail Reader File Transfer software for Windows) and can be read in the device—see the Transferring Files to the Braille Trail Reader LE section for more information.
All other folders are created when you first connect the device to the Brailliant Sync application. In this app, you can define your accounts and name the folders that correspond to the accounts—see Synchronizing the Braille Trail Reader Data section for more information.

Both the Main menu and Notes list are always shown in Computer Braille. Only when you are opening a note or file is it shown in your preferred braille. To change your preferred braille table, press Space + G (dots 1-2-4-5).

In every folder (local or synchronized) is a list of notes that belong to the account that corresponds to the folder. Typically, all notes that were stored in each account can be found there.

The Braille Trail Reader uses Computer Braille for menus, so when viewing your note or file names they are shown in Computer Braille. Once you open the note or file, the Braille Trail Reader displays the text in the way you originally wrote or transferred it to the device.

If there are not any notes, the word “empty” is shown on the braille display.

To create a new note:

1. Select the Notes item from the Braille Trail Reader’s Main menu.
2. Find the account you want to use and activate it with a cursor router or by pressing the Enter key (dot 8).
3. Press Space + N (dots 1-3-4-5) for New note. You are now in a new note.

Browse the notes with the joystick or thumb keys. Enter a note using the Spacebar or joystick down. When in the note, you edit it by using the shortcuts in Table 2: Editing Shortcuts.

<table>
<thead>
<tr>
<th>Editing Function</th>
<th>Shortcut Key or Combo</th>
</tr>
</thead>
<tbody>
<tr>
<td>New line</td>
<td>Enter or any joystick action</td>
</tr>
<tr>
<td>Backspace</td>
<td>Backspace or Space + B (dots 1-2)</td>
</tr>
<tr>
<td>Previous line (paragraph)</td>
<td>Space + dot 1, joystick up</td>
</tr>
<tr>
<td>Next line (paragraph)</td>
<td>Space + dot 4, joystick down</td>
</tr>
<tr>
<td>Previous word</td>
<td>Space + dot 2</td>
</tr>
<tr>
<td>Next word</td>
<td>Space + dot 5</td>
</tr>
<tr>
<td>Previous character</td>
<td>Space + dot 3 or joystick left</td>
</tr>
<tr>
<td>Next character</td>
<td>Space + dot 6 or joystick right</td>
</tr>
<tr>
<td>Beginning of note</td>
<td>Space + dots 1-2-3</td>
</tr>
<tr>
<td>End of note</td>
<td>Space + dots 4-5-6</td>
</tr>
<tr>
<td>Save without exiting</td>
<td>Space + S (dots 2-3-4)</td>
</tr>
<tr>
<td>Save and exit</td>
<td>Space + E (dots 1-5)</td>
</tr>
<tr>
<td>Exit without saving</td>
<td>Space + Z (dots 1-3-5-6)</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Switch Computer/Literary Braille</td>
<td>Space + G (dots 1-2-4-5)</td>
</tr>
</tbody>
</table>

**Important:** When you select “exit without saving,” you must confirm by pressing dot 8. You can cancel this function by pressing dot 7.

While editing a note, its text may be displayed on the braille display in Computer Braille or Literary Braille. Switching between the two may be done by pressing *Space + G* (dots 1-2-4-5). Specific braille conversion rules table may be set in Settings. While in a note, the cursor is represented by dots 7 and 8 in Literary Braille mode and by dot 8 while in Computer Braille mode. This indicator may be changed to blinking in the Settings menu.

**Creating and Saving Files**

The Files folder stores the files that are transferred to the device. Files can be sent to and from the Braille Trail Reader using the Braille Trail Reader File Transfer Windows application.

In the Files folder is the list of files that have been transferred to the Braille Trail Reader. The Braille Trail Reader remembers the location where you stopped reading previously and returns to that same location when you re-open the file.

All navigation commands and shortcuts are the same as with the Notes editor—see Table 2: Editing Shortcuts in the *Creating, Editing, and Saving Notes* section.

The Files folder is a read-only folder and, therefore, restricts editing and deletion. If you want to delete a file from the Files folder, connect the Braille Trail Reader to the Braille Trail File Transfer Windows application and delete the file using Operations > Delete or the hotkey F8. **Note:** This application is supported only on Windows 7, 8, and 10.

Please refer to the *Transferring Files to the Braille Trail Reader LE* section for more information.

**Synchronizing Braille Trail Reader Data**

Notes created or saved on the Braille Trail Reader can be synchronized with your Google Mail account, iCloud, and the iPhone mail application, making it easy to access your notes at any time without the hassle of using your smartphone.

For synchronization, use the Brailliant Sync app from the Apple® App Store or Google Play™ store.

**Important:** Before the app can be used, the connections in the Brailliant Sync app must be set up.

**To set up the connections in the Brailliant Sync app:**

1. Define your Note accounts (e.g., Google account) by providing the following:
   - Email address
   - Server name
   - Username
   - Password
   - Port number
• Displayed name (The corresponding folder name in the Braille Trail Reader is the same.)

**Note:** Add multiple accounts individually; all notes and accounts are synchronized to the Braille Trail Reader.

2. If not powered On, turn on your Braille Trail Reader.
3. Connect to your device by choosing “Select device.”
4. Select the serial number of your device from the displayed list.
5. Choose one from the list (It is usually the only one listed unless someone nearby is also using a Braille Trail Reader.)

Once the connections are defined, you no longer need to worry about the Brailliant Sync application on your phone. It can keep running in the background. Synchronization does not require you to go back to the app, but it must be running in background. For example, you may need to restart the app after you reboot your phone.

Synchronization is activated from the Braille Trail Reader. **Follow these steps to sync accounts:**

1. Enter Notes from the Main menu.
2. Press Space + S (dots 2-3-4) to sync accounts. The action creates accounts that did not exist before on the device. You only need to perform this if an account does not exist on your device. So typically, you would do that only if you have added a new account or changed your existing accounts in the Brailliant Sync app.
3. When finished, press Space + C (dots 1-4) to stop syncing accounts.

**Note:** If you have only recently set up the account, it may take some time to display your email account. To speed this procedure up, you can force synchronization by selecting Notes from the Main menu, and then pressing Space + S (dots 2-3-4).

From this point on, the synced accounts exchange note content (between the device and the server) every time you switch the Braille Trail Reader to Terminal mode. If you only want one or few accounts synchronized, you may disable synchronization for all other accounts in the Brailliant Sync app.

If there is a need for immediate synchronization for example, you want to synchronize immediately after editing a note to view it on your PC, do the following:

1. Enter Notes in the Main menu.
2. Enter one of the Notes folders.
3. While in the Note list, press Space + S (dots 2-3-4) to synchronize the notes. All the notes from the selected account synchronize.

Each time any notes are synchronized, the Braille Trail Reader’s System time is also synchronized with the phone time.

**Note:** If you have a lot of notes and/or if your notes are long, it may take up to an hour for a full synchronization. This happens if the notes are synchronized for the first time. **Do not** interrupt the process. The status of the process is reported on the Brailliant Sync App screen.

**Tip:** Remember to set the Sleep time long enough for the first synchronization.
To delete a note from your device, use the **Space + D** (dots 1-4-5) command while on the title of the note in the Notes list. This note is deleted from your device and (after a synchronization) from the server as well.

To remove an unused account from your device:

1. Go to the Account list
2. Select the account to delete.
3. Press the **Space + D** (dots 1-4-5) command.

When the account is deleted, all notes associated with that account are deleted from your device only. They are not deleted from the server of the account, even after being synchronized.

**Synchronizing with an iPhone**

Follow these steps to sync the Braille Trail Reader with an iPhone:

1. Download the Brailliant Sync app from the Apple® App Store.
2. Ensure Bluetooth is turned On.
   i. If not, enter your iOS Control Center by touching the status bar at the top of the screen where the time is found and perform a 3-finger swipe-up gesture. Find the Bluetooth item and turn it On.
3. On your iPhone Home screen, double tap to activate the Brailliant Sync app.
4. Double tap on the Add an account button.
5. Select if you have a Google or other account by double tapping on the appropriate item.
6. Fill in your account info.
7. Double tap on Save (top right corner of screen) when done.

Within a few seconds, your account appears on your Braille Trail Reader, after you select the Notes item in the Main menu.

If you have set up your mail app to sync notes in the iOS settings under mail, then you can use the Notes app on your iPhone to access device notes that have been synchronized. To set your email account to sync notes:

1. Open the iOS Settings app
2. Activate Notes.
3. Activate your account.
4. Ensure that Notes are set to On.

**Synchronizing with iCloud**

It is possible to use the iCloud account with the Brailliant Sync app. However, first you need to ensure your Apple ID is secured by enabling the two-factor authentication. In addition, as the Brailliant Sync application is not a service provided by Apple, an app-specific password must be generated.

Because iCloud does not support the IMAP protocol by default, you must add a new email client. Follow these steps to add an email client:

1. Go to Settings > Accounts & Passwords.
2. Double tap Add Account.
3. Double tap Other.
4. Tap Add Mail Account.
5. Enter the following information:
   a. Name: Your name
   b. Email: Your iCloud email address
   c. Password: Your app-specific password—NOT the account password
   d. Description: Any name can be placed here to associate the account being used.
1. Double tap next. Mail finds the email settings and finishes your account setup.

2. **Important:** Double tap the Ok button to edit the server details, when prompted with the message: The IMAP server automatically added for iOS & OS X mail is not responding...

3. Enter the following server details:
   - **Incoming mail server**
     - Host Name: imap.mail.me.com
     - Username: the name part of your iCloud email address (e.g., emilyparker, not emilyparker@icloud.com)
   - Password: Your app-specific password
   - **Outgoing mail server**
     - Host Name: smtp.mail.me.com
     - Username: the name part of your iCloud email address (e.g., emilyparker, not emilyparker@icloud.com)
   - Password: Your app-specific password

4. Double tap Next to finish. If the email settings are incorrect, you are asked to edit them.

If the account has successfully been validated, you are prompted to select the services you require. **Note:** Before you begin the following steps, ensure that Notes is enabled.

To select services:
1. Double tap Save.
2. Download the Brailliant Sync app from the Apple® App Store.
3. Ensure that Bluetooth is turned On. If it is not On, enter your iOS control center by touching the status bar at the top of the screen (where the time is found), and perform a 3-finger swipe up gesture. Find the Bluetooth item and turn it On.
4. On your Home screen, double tap to activate the Brailliant Sync app.
5. Turn on the Braille Trail Reader.
6. Double tap Select Device.
7. You are given a list of found devices. Double tap the serial number linking to your Braille Trail Reader.
8. Double tap on the Add an Account button.
9. Select Other Account by double tapping.
10. Add the following information in the provided editable fields.
    a. E-mail: Enter your iCloud email address
    b. Host Server: imap.mail.me.com
c. Username: the name part of your iCloud email address (e.g., emilyparker, not emilyparker@icloud.com)
d. Password: Your app-specific password (same as previous app-specific password)
e. Port: 993
f. Display Name: Any name can be placed here to associate the account being used.
g. Double tap Check account.

11. If all the above settings are correct, you are prompted “Account settings have been checked successfully.”
12. Double tap the OK button.
13. Double tap the Save button.
14. You can now return to the Home screen.

How to Generate an App-Specific Password
2. You are asked to enter your Apple ID followed by your Apple ID password.
3. Providing you have enabled the two-factor authentication, you are prompted to enter a code. A message with a verification code would have been sent to the device. Enter the code to continue.
4. In the Security section, click Generate Password below App-Specific Passwords.
5. You are prompted to enter a password label. Type BrailleTrail and select the Create button.
6. You are prompted with the app-specific password. **Important:** Make a note of this password as it is used for all the password fields. **Note:** Password is case-sensitive.

When finished, you do not see that App password code again. However, you do see a list of apps and devices you’ve created App passwords for.

7. Return to the Brailliant Sync App and enter your username.
8. Replace your password with the app-specific password generated. This gives you access to your account through the Brailliant Sync App.

Turning on Two-Factor Authentication in Settings
If you’re using iOS 10.3 or later:
2. Double Tap “Turn On Two-Factor Authentication.”
3. Double Tap Continue.
4. Enter the phone number where you want to receive verification codes when you sign in. You can choose to receive the codes by text message or automated phone call.
5. Double tap Next.
6. Apple sends a verification code to the phone number you provided. Enter the verification code to verify your phone number.
7. Turn On Two-factor authentication.

Synchronizing with Outlook
If you have configured Outlook to use your email client, you are able to synchronize your notes to and from the Braille Trail Reader.
You can create a note from any Outlook folder.

Follow these steps to create a note within Outlook:

1. In Notes, on the Home tab, in the New group, click **New Note**.
2. **(Alternative)** Press the keyboard shortcut Ctrl + Shift + N to create a note.
3. Type the text of the note. The note saves automatically, providing you have set up your email client in the Brailliant Sync Application, it automatically synchronizes your note.
4. To close the note, press **Space + E** (dots 2-3).

**Synchronizing with Gmail**

There are several steps required to establish the Gmail synchronization.

First, it is essential that you turn on IMAP syncing in the Gmail site. **To turn on IMAP syncing in Gmail:**

1. Log into [www.gmail.com](http://www.gmail.com).
2. Select Settings.
3. Choose the “Forwarding and Pop / IMAP” link.
4. Ensure that IMAP is enabled and Save the settings.

To send a note through Gmail, you must create a filter. **Follow these steps to create a filter:**

1. Log into your Gmail email account using your email address and password.
2. Navigate to Settings in the upper right corner of the screen and select the Label tab.
3. Click on Create New Label.
4. Name your new label with something easy to remember (e.g., Notes).
5. Click on the Filter tab and select Create New filter.
6. In the “To:” section of the new filter, insert your Gmail name (of your Gmail address) followed by [email] +Notes@gmail.com. For example, if your email address is Braille.Trail@gmail.com, you write Braille.Trail+Notes@gmail.com.
7. Click “Create filter with this search.”
8. Check the box Apply the Label.
9. Select the new label: Notes.

You should test your Note feature to ensure it is set up correctly by sending an email to the new email address you just created. You know it is set up correctly if the note arrives in your newly created notes folder.

Now, all notes taken on your Braille Trail Reader are synced with your notes folder in Gmail.

**Transferring Files to the Braille Trail Reader LE**

The second item in the Notes menu is Files. This folder shows a list of files that have been transferred to the device using the Braille Trail Reader File Transfer Windows application. You can open any of the files in the Braille Trail Reader for reading. At this time, the Braille Trail Reader application does not support the macOS® operating system software. Use the Windows application to transfer .brf and .txt files.
The Braille Trail Reader File Transfer Windows application is used to transfer files from a PC to the Braille Trail Reader. The application shows files converted to braille presented in the left pane (PC Files pane) and Braille Trail Reader files in the right pane (Reader Files Pane). File types that can be transferred to the device are .txt and .brf.

The transfer is basically a two-step process. A simplified explanation of the process happening on the device is you copy the files to the left pane (PC Files pane) of the Braille Trail Reader File Transfer app. At this moment, conversion from the source file format to braille is performed. (The braille grade—computer or literary—and language can be decided by the user in a dialog box.) Then, you can copy the converted file to the Braille Trail Reader. The menu command “Add to PC Pane and Transfer” performs both steps at once.

For the Braille Trail Reader to be recognized, it requires the serial channel connection to be free. If you are currently using your Braille Trail Reader with a screen reader, remove the device from the Screen Reader braille settings. You cannot connect the Braille Trail Reader to the File Transfer application while using it as a braille display.

**Copying Files from a PC to the Braille Trail Reader (in 3 Parts)**

Copying files over to your Braille Trail Reader is not as complicated as it seems. Think of doing the following steps in 3 parts to ease the process.

In Part 1, you copy the files to the File Transfer Windows app. This takes place on the PC. In Part 2, you connect your Braille Trail Reader to the File Transfer Windows app with the USB cable. Last, for Part 3, you copy the files from the File Transfer Windows app to the Braille Trail Reader.

**Note:** You must complete all the steps and all three parts of the process to successfully copy files from the PC to the Braille Trail Reader.

**Part 1: Copy Files from a PC Folder to the Braille Trail Reader File Transfer Windows Application**

To copy your file from a PC folder to the Braille Trail Reader File Transfer app:

1. Go to the Files menu and choose Add to PC Pane. You are presented the typical Windows file open dialog.
2. Drag and drop the file(s) from anywhere in Windows interface (the Desktop, Windows Explorer, etc.) to the left pane of the Braille Trail Reader File Transfer app.
3. Alternatively, copy a file(s) (Ctrl + C) and paste it (Ctrl + V) into the left pane of the Braille Trail Reader File Transfer Windows app.

These methods work for .txt and .brf files only. The Windows file open dialog only shows these types of files.

You can convert other types of files to view on your Braille Trail Reader, such as Word files (.doc).

**To convert a .doc file to a .txt file:**

1. Open the Word file using MS Word.
2. Select File > Save as.
3. A dialog box opens where you can change the file name and the file type. Navigate to the file type and select Plain Text file from the drop-down menu.
4. Select Save. Note: Make a note where you save the file.
This saved file can now be used in conjunction with the Braille Trail File Transfer application.

After a .txt or .brf file copy is initiated, a braille conversion mode dialog box opens with a choice of braille grades and languages. You may choose between Computer Braille and Literary Braille, and the language of conversion. There is also an “Always Ask” checkbox below the list of languages. If you uncheck this box, the Conversion Mode is always performed with the settings chosen. If you leave this box checked, the Conversion Mode dialog box opens every time you select a file to copy.

If you are downloading a file from Bookshare, the file may only be available in .doc and .docx file formats. If so, follow the instructions to convert the file to a .txt format. However, if it is available, we recommend downloading the .brf version of the file. Once downloaded, use the free Braille Trail File Transfer application to copy the book to the Braille Trail Reader. The Braille Trail Reader application can be downloaded from [the Braille Trail Reader page on aph.org](http://aph.org).

**Part 2: Connecting the Braille Trail Reader with the Braille Trail Reader File Transfer Windows App**

To perform any file transfer operation between the PC and the Braille Trail Reader, you must connect the two devices.

**To connect the two devices:**

1. Connect the Braille Trail Reader to the PC with the USB cable (included in the box).
2. Press the Connect button above the right pane of the Braille Trail Reader File Transfer application.
3. Alternatively, use the Connect option from the Reader menu.

If successful, the status bar at the bottom of the application window shows the message “CONNECTED” in green. At the same time, the message “transfer mode” is shown on the Braille Trail Reader display.

**Part 3: Copying Files from the Braille Trail Reader File Transfer Windows App to the Braille Trail Reader**

Copying the converted files to the Braille Trail Reader is done in the Braille Trail Reader File Transfer app by copying from the left pane (PC Files pane) to the right pane (Reader Files pane). **Important:** The files can be copied only if the device is correctly connected (CONNECTED message in the app’s status bar).

**To copy, delete, and preview files, you can use one of the keyboard shortcuts:**

- **Space** for selecting/deselecting an item
- **F3** to preview a selected file (does not work for multiple files—you get an error message if more than one file is selected)
- **F5** for copying a selected file(s) to the right pane (Reader Files pane)
- **F8** for deleting a selected file(s)
- **Alt + Enter** to show details of the file (name, extension, size, and modification date in a dialog box)

You can also choose one of these options from the Operations menu: Select, Preview, Copy, Delete, or Details.

Copying files to the Braille Trail Reader is not as fast as PC file transfer, so files larger than one megabyte may take a minute or more to copy. There is a slight difference in the file size once you have transferred a file to the Braille Trail Reader. The reason has to do with the conversion process (text to braille). Files transferring to the Braille Trail Reader are translated using your Duxbury Braille table choice. For example, in the device one Braille character (sign) is one byte, but in text this can be few letters (bytes).
Copying Files from PC Pane to a Windows Folder

The files that are seen in PC Pane of the Braille Trail Reader File Transfer app are in a braille format. To copy them to a Windows folder they must be converted to text, which is performed during the copy operation.

Customer Support

USA Only

For customer support in the U.S., please contact APH Customer Service at 800-223-1839 or cs@aph.org.

Europe and Other Countries

For customer support outside of the U.S., please contact the HumanWare office nearest you or view our website at: www.humanware.com.

Europe: (0044) 1933 415800 or send an email to eu.support@humanware.com.

Australia / Asia: (02) 9686 2600 or send an email to au.sales@humanware.com.

Proper Trademark Notice and Attributions

macOS is a registered trademark of Apple Inc.

JAWS is a registered trademark of Freedom Scientific, Inc. in the United States and other countries.

Bookshare® is a registered trademarks of Beneficent Technology, Inc.

Bluetooth is a registered trademark of Bluetooth SIG, Inc.

IOS is a trademark or registered trademark of Cisco in the U.S. and other countries and is used under license.

All other trademarks are the property of their respective owners.

Additional Resources

For additional resources, including more information about braille literacy, fun and engaging student activities, and to order a complimentary Classroom Kit, please visit www.braillebug.org.

Technical Specifications

Navigation Components:

- 4 thumb keys
- 1 joystick (up, right, down, left, action)
- 8-key braille keyboard
- 1 Spacebar
- 14 touch cursor routing keys
- 14 braille cells

Long-life Battery:
• Lasts 10 hours or more
• Recharges from PC through USB port
• Auto shut-off
• Lithium-ion polymer battery
• Compatible with any standard USB A/C adapter
• Voltage rating: 3.7V

Connectivity:
• USB 2.0
• Bluetooth V2.1 + EDR Class 2
• Bluetooth 4.0

Portability:
• Size: 166x100x23 [mm]
• Weight: 285g, 0.63 lbs.

Compatibility:
• Windows computers (32 and 64 bits)
• JAWS and other screen readers
• Apple products with iOS 10 or MacOS 10.12 and VoiceOver (MAC, iPhone, iPad, iPod Touch)

End User License Agreement
By using this Product (Braille Trail Reader LE), you agree to the following minimum terms:

1. **License Grant.** HumanWare grants to End User a non-exclusive, non-transferable right and license to use the Software on this product.

2. **Ownership of Software.** End User acknowledges that HumanWare retain all right, title and interest in and to the original, and any copies, of software which is incorporated into this product. End User agrees not to: modify, port, translate, decompile, disassemble, reverse engineer, or make public in any way the software of this Product.

Manufacturer Warranty

**Manufacturer Warranty**
The Braille Trail Reader is a high-quality product, built and packaged with care. All units and components are guaranteed against any operational defects for one (1) year.

Warranty covers all parts (except battery) and labor. If any defect should occur, please contact APH Customer Service at 800-223-1839.

**Conditions and Limitations:**
Please keep your bill of purchase in a safe place as it may be required for a warranty repair or replacement. Please retain your original. If the unit has to be returned, please use the original packaging. This warranty applies to all cases where the damage is not a result of improper use, mistreatment, negligence or acts of God.
In addition to the warranty, you can also purchase a Service Contract directly from HumanWare to prolong coverage for one year and also benefit from the cleaning service. Please refer to http://www.humanware.com/, or contact HumanWare at us.info@humanwarecom, or 800-722-3393.